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Chapter 221

Group-Sequential
Tests for Two
Proportions
(Simulation)

Introduction

This procedure can be used to determine power, sample size and/or boundaries for group sequential tests comparing
the proportions of two groups. The tests that can be simulated in this procedure are the common two-sample Z-test
with or without pooled standard error and with or without continuity correction, the Mantel-Haenszel test, the T-test,
and Fisher’s Exact test. For two-sided tests, significance (efficacy) boundaries can be generated. For one-sided tests,
significance and futility boundaries can be produced. The spacing of the looks can be equal or custom specified.
Boundaries can be computed based on popular alpha- and beta-spending functions (O’Brien-Fleming, Pocock,
Hwang-Shih-DeCani Gamma family, linear) or custom spending functions. Boundaries can also be input directly to
verify alpha- and/or beta-spending properties. Futility boundaries can be binding or non-binding. Maximum and
average (expected) sample sizes are reported as well as the alpha and/or beta spent and incremental power at each
look. Corresponding P-Value boundaries are also given for each boundary statistic. Plots of boundaries are also
produced.

Technical Details

This section outlines many of the technical details of the techniques used in this procedure including the simulation
summary, the test statistic details, and the use of spending functions.

An excellent text for the background and details of many group-sequential methods is Jennison and Turnbull (2000).

Simulation Procedure

In this procedure, a large number of simulations are used to calculate boundaries and power using the following
steps

1. Based on the specified proportions, random samples of size N1 and N2 are generated under the null
distribution and under the alternative distribution. These are simulated samples as though the final look is
reached.
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2. For each sample, test statistics for each look are produced. For example, if N1 and N2 are 100 and there are
5 equally spaced looks, test statistics are generated from the random samples at N1 = N2 =20, N1 =N2 =
40, N1 =N2 =60, N1 =N2 =80, and N1 = N2 =100 for both null and alternative samples.

3. To generate the first significance boundary, the null distribution statistics of the first look (e.g., at N1 = N2 =
20) are ordered and the percent of alpha to be spent at the first look is determined (using either the alpha-
spending function or the input value). The statistic for which the percent of statistics above (or below, as the
case may be) that value is equal to the percent of alpha to be spent at the first look is the boundary statistic.
It is seen here how important a large number of simulations is to the precision of the boundary estimates.

4. All null distribution samples that are outside the first significance boundary at the first look are removed
from consideration for the second look. If binding futility boundaries are also being computed, all null
distribution samples with statistics that are outside the first futility boundary are also removed from
consideration for the second look. If non-binding futility boundaries are being computed, null distribution
samples with statistics outside the first futility boundary are not removed.

5. To generate the second significance boundary, the remaining null distribution statistics of the second look
(e.g., at N1 = N2 = 40) are ordered and the percent of alpha to be spent at the second look is determined
(again, using either the alpha-spending function or the input value). The percent of alpha to be spent at the
second look is multiplied by the total number of simulations to determine the number of the statistic that is
to be the second boundary statistic. The statistic for which that number of statistics is above it (or below, as
the case may be) is the second boundary statistic. For example, suppose there are initially 1000 simulated
samples, with 10 removed at the first look (from, say, alpha spent at Look 1 equal to 0.01), leaving 990
samples considered for the second look. Suppose further that the alpha to be spent at the second look is 0.02.
This is multiplied by 1000 to give 20. The 990 still-considered statistics are ordered and the 970" (20 in
from 990) statistic is the second boundary.

6. All null distribution samples that are outside the second significance boundary and the second futility
boundary, if binding, at the second look are removed from consideration for the third look (e.g., leaving 970
statistics computed at N1 = N2 = 60 to be considered at the third look). Steps 4 and 5 are repeated until the
final look is reached.

Futility boundaries are computed in a similar manner using the desired beta-spending function or custom beta-
spending values and the alternative hypothesis simulated statistics at each look. For both binding and non-
binding futility boundaries, samples for which alternative hypothesis statistics are outside either the significance
or futility boundaries of the previous look are excluded from current and future looks.

Because the final futility and significance boundaries are required to be the same, futility boundaries are
computed beginning at a small value of beta (e.g., 0.0001) and incrementing beta by that amount until the futility
and significance boundaries meet.

When boundaries are entered directly, this procedure uses the null hypothesis and alternative hypothesis
simulations to determine the number of test statistics that are outside the boundaries at each look. The
cumulative proportion of alternative hypothesis statistics that are outside the significance boundaries is the
overall power of the study.

Small Sample Considerations

When the sample size is small, say 200 or fewer per group, the discrete nature of the number of possible differences
in proportions in the sampling distribution comes into play. This has led to a large number of proposed tests for
comparing two proportions (or testing the 2 by 2 table of counts). For example, Upton (1982) considers twenty-two
alternative tests for comparing two proportions. Sweeping statements about the power of one test over another are
impossible to make, because the size of the Type | error depends upon the proportions used. At some proportions,
some tests are overly conservative while others are not, while at other proportions the reverse may be true.

This simulation procedure, however, is based primarily on the ordering of the sample statistics in the simulation. The
boundaries are determined by the spending function alphas. Thus, if a test used happens to be conservative in the
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single-look traditional sense, the boundaries chosen in the simulation results of this procedure will generally remove
the conservative nature of the test. This makes comparisons to the one-look case surprising in many cases.

Definitions

Suppose you have two populations from which dichotomous (binary) responses will be recorded. The probability
(or risk) of obtaining the event of interest in population 1 (the treatment group) is P, and in population 2 (the
control group) is P, . The corresponding failure proportions are givenby ¢, =1-p, and 9, =1-p,.

The assumption is made that the responses from each group follow a binomial distribution. This means that the

event probability, p;, is the same for all subjects within the group and that the response from one subject is
independent of that of any other subject.

Random samples of m and n individuals are obtained from these two populations. The data from these samples
can be displayed in a 2-by-2 contingency table as follows

Group Success Failure Total
Treatment a c m
Control b d

Total S f N

The following alternative notation is also used.

Group Success Failure Total
Treatment X1 X5 n,
Control Xy Xy, n,
Total m, m, N

The binomial proportions p, and p, are estimated from these data using the formulae

Aoa Xy . b xy

p=—=-—"and p,=—=
m n n n,

Comparing Two Proportions

When analyzing studies such as this, one usually wants to compare the two binomial probabilities, p,and p, .
Common measures for comparing these quantities are the difference and the ratio. If the binomial probabilities are
expressed in terms of odds rather than probabilities, another common measure is the odds ratio. Mathematically,
these comparison parameters are

Parameter Computation
Difference S=p-p,

Risk Ratio d=p!p,

Odds Ratio _h/(-p) _ B9,

- pz /(1_ pz) pqu
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The (risk) difference, 6 = p, — p,, is perhaps the most direct measure for comparing two proportions. Three sets
of statistical hypotheses can be formulated:

1. Hy:p,—p, =0 versus H;:p, — p, #0; this is often called the two-tailed test.
2. Hyip,—p, <0 versus H,:p, — p, > 0; this is often called the upper-tailed test.
3. Hyip,— P, 20 versus H;:p, — p, <0; this is often called the lower-tailed test.

In this procedure, whether the parameterization is in terms of proportions, differences, risk ratios, or odds ratios,
the hypothesis tests concerning the differences are those that are simulated.

Test Statistics

This section describes the test statistics that are available in this procedure.

Z Test (Pooled and Unpooled)
This test statistic was first proposed by Karl Pearson in 1900. Although this test can be expressed as a Chi-Square
statistic, it is expressed here as a z so that it can be used for one-sided hypothesis testing.

Both pooled and unpooled versions of this test have been discussed in the statistical literature. The pooling refers
to the way in which the standard error is estimated. In the pooled version, the two proportions are averaged, and
only one proportion is used to estimate the standard error. In the unpooled version, the two proportions are used
separately.

The formula for the test statistic is

Pooled Version

np, +np,
n+n,

p:

Unpooled Version

Continuity Correction

Frank Yates is credited with proposing a correction to the Pearson Chi-Square test for the lack of continuity in the
binomial distribution. However, the correction was in common use when he proposed it in 1922.

A o F(1 1
PESRIENY

n n

The continuity corrected z-test is

Sp
where F is -1 for upper-tailed, 1 for lower-tailed, and either -1 or 1 for two-sided hypotheses, depending on
whether the numerator difference is positive or negative.
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Conditional Mantel Haenszel Test

The conditional Mantel Haenszel test, see Lachin (2000) page 40, is based on the index frequency, X;, , from the
2x2 table. The formula for the z-statistic is

Z=X11 E(Xll)
Vc(Xll)
where
nm
E 1
(%) N
(%) = n,N,Mm,
HUN?(N -1
T-Test

Based on a study of the behavior of several tests, D’Agostino (1988) and Upton (1982) proposed using the usual
two-sample t-test for testing whether two proportions are equal. One substitutes a ‘1’ for a success and a ‘0’ for a
failure in the usual, two-sample t-test formula. The test statistic is computed as

1

N-2 )
vz =(ad - bc)( N(nac + mbd)]

which can be compared to the t distribution with N-2 degrees of freedom.

Fisher's Exact Test

The most useful reference we found for power analysis of Fisher’s Exact test was in the StatXact 5 (2001)
documentation. The material present here is summarized from Section 26.3 (pages 866 — 870) of the StatXact-5
documentation. In this case, the test statistic is

Xl X2

u
m
The null distribution of T is based on the hypergeometric distribution. It is given by
)
X\ X
Pr(T >t|m, Hy)= > | ——*
A(m) (Nj

m

T=-In

where
A(m) = {all pairs x,, X, such that x, + x, = m, given T >t}

Conditional on m, the critical value, t_, is the smallest value of t such that

a!

Pr(T >t,|m Hy)<a
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The power is defined as

1-B= i P(m)Pr(T >t,[m H,)

where

b(%y, My, Py)0(X,, Nz Py)

) (Z:)b(xl’ n, pl)b(XZ’ Ny, pz)
A(m

Pr(T >t,ImH,)= >

A(mT>t,

P(m) = Pr(x, + x, = m/H,)
= b(X,, Ny, Py )B(X,, 1y, )

b(x,n, p) = @ p'(L-p)""

Spending Functions

Spending functions can be used in this procedure to specify the proportion of alpha or beta that is spent at each
look without having to specify the proportion directly.

Spending functions have the characteristics that they are increasing and that
a(0)=0
a(l) =

The last characteristic guarantees a fixed « level when the trial is complete. This methodology is very flexible
since neither the times nor the number of analyses must be specified in advance. Only the functional form of

a(7) must be specified.

PASS provides several popular spending functions plus the ability to enter and analyze your own percents of
alpha or beta spent. These are calculated as follows (beta may be substituted for alpha for beta-spending
functions):

-

e_}’

1. Hwang-Shih-DeCani (gamma family) 0{1 } y#0; at,y=0

O'Brien-Fleming Boundaries with Alpha = 0.05

5 o
4 \\\\
3t e —
-
2+ . - —e
% 1+ ® Upper
E 0 | | } | |
N 1 2 3 4 5

u |ower
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2. O’Brien-Fleming Analog

2_20d @

Jt

O'Brien-Fleming Boundaries with Alpha = 0.05

® Upper

Z Value

Look

= Lower

3. Pocock Analog  a-In(L+ (e —1)t)

Pocock Boundaries with Alpha = 0.05

50
33+
A . . °
1.7
g ® Upper
§ 0.0 | | | | |
N 1 2 3 4 5
17 = |ower
- = —a
3.3+
5.0~
Look
4. Alpha*time «-t
(Alpha)(Time) Boundaries with Alpha = 0.05
5.0+
3.3+
| S I G Y
1.7+
% ® Upper
3
> 00 | | } |
N 1 2 3 4 5
1.7+ = Lower
- = = —=—H™®
-3.3+
5.0+
Look
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5. Alpha*timerl5 o-t¥?

(Alpha)(Time”1.5) Boundaries with Alpha = 0.05
5.0

3.34-
- —
0—77,,,.77777.7777.
17+
% ® Upper
> 00 } | } } ]
N 1 2 3 4 5
17+ = Lower
==
"
_33 —+
-5.0--
Look

6. Alpha*timer2 «-t°

(Alpha)(Time”2.0) Boundaries with Alpha = 0.05
5.0

3.3+ [
—e 777.———————0——————0
1.7+
. ® Upper
< 40 ‘ i } } }
N 1 ? ? 1 ]
L = | ower
_  m— =
334 e —
5.0
Look
. C
7. Alpha*time"C «-t
(Alpha)(Time”~2.0) Boundaries with Alpha = 0.05
5.0
3.3+ [
—e 777.———————0——————0
1.7+
. ® Upper
< 40 ‘ i } } }
N 1 ? ? 1 ]
L = | ower
_  m— =
334 e —
5.0

Look

8. User Supplied Percents
A custom set of percents of alpha to be spent at each look may be input directly.

The O'Brien-Fleming Analog spends very little alpha or beta at the beginning and much more at the final looks.
The Pocock Analog and (Alpha or Beta)(Time) spending functions spend alpha or beta more evenly across the
looks. The Hwang-Shih-DeCani (C) (gamma family) spending functions and (Alpha or Beta)(Time”~C) spending
functions are flexible spending functions that can be used to spend more alpha or beta early or late or evenly,

depending on the choice of C.
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Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design, Looks &
Boundaries, and Options tabs. For more information about the options of other tabs, go to the Procedure Window
chapter.

Design Tab

The Design tab contains most of the parameters and options for the general setup of the procedure.

Solve For
Solve For
Solve for either power, sample size, or enter the boundaries directly and solve for power and alpha.

When solving for power or sample size, the early-stopping boundaries are also calculated. High accuracy for
early-stopping boundaries requires a very large number of simulations (Recommended 100,000 to 10,000,000).

The parameter selected here is the parameter displayed on the vertical axis of the plot.

Because this is a simulation-based procedure, the search for the sample size may take several minutes or hours to
complete. You may find it quicker and more informative to solve for Power for a range of sample sizes.

Test and Simulations
Test Type
Specify which test statistic is to be simulated and reported on.

The Z-test has the difference of the proportions in the numerator and a standard error of the difference in the
denominator.

Pooled and unpooled refer to the method of estimating the standard error used in the denominator.
C. C. stands for continuity correction.
For details and formulation of the Z, Mantel-Haenszel, T, and Fisher's Exact tests, see the help manual.

Alternative Hypothesis

Specify the alternative hypothesis of the test. Since the null hypothesis is the opposite, specifying the alternative is
the only hypothesis needed.

When a two-sided alternative is selected, futility boundaries are not permitted. If you wish to do a two-sided test
with futility boundaries you may consider two one-sided tests.

Care need be taken in the choice of direction of the test relative to the choice of P1 and P2. For example, for a
one-sided test to show that the true proportion for group 1 (treatment) is less than the true proportion for group 2
(control), P1 should be smaller than P2 and the alternative hypothesis chosen should be One-Sided (P1 < P2).
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Simulations
Specify the number of Monte Carlo iterations, M.
The following table gives an estimate of the precision that is achieved for various simulation sizes when the

power is near 0.50 and 0.95. The values in the table are the "Precision™ amounts that are added and subtracted to
form a 95% confidence interval.

Simulation Precision Precision
Size when when

M Power = 0.50 Power = 0.95

100 0.100 0.044
500 0.045 0.019
1000 0.032 0.014
2000 0.022 0.010
5000 0.014 0.006
10000 0.010 0.004
50000 0.004 0.002
100000 0.003 0.001

However, when solving for power or sample size, the simulations are used to calculate the look boundaries. To
obtain precise boundary estimates, the number of simulations needs to be high. However, this consideration
competes with the length of time to complete the simulation. When solving for power, a large number of
simulations (100,000 or 1,000,000) will finish in several minutes. When solving for sample size, perhaps 10,000
simulations can be run for each iteration. Then, a final run with the resulting sample size solving for power can be
run with more simulations.

Power and Alpha

Power

Power is the probability of rejecting the null hypothesis when it is false. Power is equal to 1-Beta, so specifying
power implicitly specifies beta.

Beta is the probability obtaining a false negative on the statistical test. That is, it is the probability of accepting a
false null hypothesis.

In the context of simulated group sequential trials, the power is the proportion of the alternative hypothesis
simulations that cross any one of the significance (efficacy) boundaries.

The valid range is between 0 and 1.

Different disciplines and protocols have different standards for setting power. A common choice is 0.90, but 0.80
is also popular.

You can enter a range of values such as 0.70 0.80 0.90 or 0.70 to 0.90 by 0.1.

Alpha

Alpha is the probability of obtaining a false positive on the statistical test. That is, it is the probability of rejecting
a true null hypothesis.

The null hypothesis is usually that the parameters (the means, proportions, etc.) are all equal.

In the context of simulated group sequential trials, alpha is the proportion of the null hypothesis simulations that
cross any one of the significance (efficacy) boundaries.

Since Alpha is a probability, it is bounded by 0 and 1. Commonly, it is between 0.001 and 0.250.
Alpha is often set to 0.05 for two-sided tests and to 0.025 for one-sided tests.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
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Sample Size (When Solving for Sample Size)

Group Allocation

Select the option that describes the constraints on N1 or N2 or both.
The options are

e Equal (N1=N2)

This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

e Enter N2, solve for N1

Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

e Enter R =N2/N1, solve for N1 and N2

For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is

N2 =R * N1.

e Enter percentage in Group 1, solve for N1 and N2

For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be > 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R=N2/N1.

Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.

N2 is related to N1 by the formula:
N2 =[R x N1],
where the value [Y] is the next integer > Y.

For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 =50 and N2 = 100).

R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
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Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)

Group Allocation

Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are

e Equal (N1=N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

e Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

o Enter N1 and R, where N2 =R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

o Enter total sample size and percentage in Group 1

Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = ““Equal (N1 = N2).”

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.

The Sample Size Per Group must be > 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)

This option is displayed if Group Allocation = “Enter N1 and N2 individually’” or “Enter N1 and R, where N2 =
R*NL1.”

N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be > 2. You can enter a single value or a series of values.

N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.

N2 is the number of items or individuals sampled from the Group 2 population.

N2 must be > 2. You can enter a single value or a series of values.
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R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = ““Enter N1 and R, where N2 =R * N1.”
R is the ratio of N2 to N1. That is,

R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:

N2=[R x N1],

where the value [Y] is the next integer > Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.

R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.

Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.

You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size

Input Type

Indicate what type of values to enter to specify the effect size. Regardless of the entry type chosen, the test
statistics used in the power and sample size calculations are the same. This option is simply given for convenience
in specifying the effect size.

P1 (Treatment Group Proportion|H1) — Proportions
P1 is the proportion used in the simulations for Group 1 under H1.

The range is 0 to 1, but not zero or one. If the alternative hypothesis is one-sided, this value should reflect the
direction of the one-sided test.

When P1 is close to zero or one, a Zero Count Adjustment may be needed.
You can enter a list of values such as 0.4 0.5 0.6 or 0.3 to 0.7 by 0.05.

221-13
© NCSS, LLC. All Rights Reserved.



PASS Sample Size Software NCSS.com
Group-Sequential Tests for Two Proportions (Simulation)

D1 (Difference|H1 = P1-P2) — Differences
D1 is used to calculate P1, the proportion used in the simulations for Group 1 under H1.
P1=P2+D1

The range is -1 to 1, but not -1 or 1. This value should only result in values of P1 that are between 0 and 1. If the
alternative hypothesis is one-sided, this value should reflect the direction of the one-sided test.

When the resulting P1 is close to zero or one, a Zero Count Adjustment may be needed.
You can enter a list of values such as 0.4 0.5 0.6 or 0.3 to 0.7 by 0.05.

R1 (Ratio|H1 = P1/P2) — Ratios

R1 is used to calculate P1, the proportion used in the simulations for Group 1 under H1.
P1=R1*P2

Although P1 is specified in terms of the ratio of P1 to P2, the simulated tests use the difference between P1 and
P2.

The range is greater than zero, but typically not 1. This value should only result in values of P1 that are between 0
and 1. If the alternative hypothesis is one-sided, this value should reflect the direction of the one-sided test.

When the resulting P1 is close to zero or one, a Zero Count Adjustment may be needed.
You can enter a list of values suchas 1.1 1.2 1.3 or 1.1 to 1.4 by .05.

OR1 (Ratio|H1 = 01/02) — Odds Ratios

OR1 is used to calculate P1, the proportion used in the simulations for Group 1 under H1.
OR1 = [P1/(1-P1))/[P2/(1-P2)] and P1 =[OR1 * P2] / [1 - P2 + OR1 * P2]

Although P1 is specified in terms of the oddes ratio of P1 to P2, the simulated tests use the difference between P1
and P2.

The range is greater than zero, but typically not 1. This value should only result in values of P1 that are between 0
and 1. If the alternative hypothesis is one-sided, this value should reflect the direction of the one-sided test.

When the resulting P1 is close to zero or one, a Zero Count Adjustment may be needed.

You can enter a list of values such as 1.1 1.2 1.3 or 1.1 to 1.4 by .05.

P2 (Group 2 Proportion)

P2 is the proportion used in the simulations for Group 1 and Group 2 under HO, and for Group 2 under H1.
The range is 0 to 1, but not zero or one.

When P2 is close to zero or one, a Zero Count Adjustment may be needed.

You can enter a list of values such as 0.4 0.5 0.6 or 0.3 to 0.7 by 0.05.
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Looks & Boundaries Tab when Solving for Power or Sample Size

The Looks & Boundaries tab contains settings for the looks and significance boundaries.

Looks and Boundaries

Specification of Looks and Boundaries

Choose whether spending functions will be used to divide alpha and beta for each look (Simple Specification), or
whether the percents of alpha and beta to be spent at each look will be specified directly (Custom Specification).

Under Simple Specification, the looks are automatically considered to be equally spaced. Under Custom
Specification, the looks may be equally spaced or custom defined based on the percent of accumulated
information.

Looks and Boundaries — Simple Specification

Number of Equally Spaced Looks
Select the total number of looks that will be used if the study is not stopped early for the crossing of a boundary.

Alpha Spending Function

Specify the type of alpha spending function to use.

The O'Brien-Fleming Analog spends very little alpha at the beginning and much more at the final looks. The
Pocock Analog and (Alpha)(Time) spending functions spend alpha more evenly across the looks. The Hwang-
Shih-DeCani (C) (sometimes called the gamma family) spending functions and (Alpha)(Time”C) spending

functions are flexible spending functions that can be used to spend more alpha early or late or evenly, depending
on the choice of C.

C (Alpha Spending)
C is used to define the Hwang-Shih-DeCani (C) or (Alpha)(Time”C) spending functions.

For the Hwang-Shih-DeCani (C) spending function, negative values of C spend more of alpha at later looks,
values near 0 spend alpha evenly, and positive values of C spend more of alpha at earlier looks.

For the (Alpha)(Time”C) spending function, only positive values for C are permitted. Values of C near zero spend
more of alpha at earlier looks, values near 1 spend alpha evenly, and larger values of C spend more of alpha at
later looks.

Type of Futility Boundary

This option determines whether or not futility boundaries will be created, and if so, whether they are binding or
non-binding.

Futility boundaries are boundaries such that, if crossed at a given look, stop the study in favor of HO.

Binding futility boundaries are computed in concert with significance boundaries. They are called binding

because they require the stopping of a trial if they are crossed. If the trial is not stopped, the probability of a false
positive will exceed alpha.

When non-binding futility boundaries are computed, the significance boundaries are first computed, ignoring the
futility boundaries. The futility boundaries are then computed. These futility boundaries are non-binding because
continuing the trial after they are crossed will not affect the overall probability of a false positive declaration.

Number of Skipped Futility Looks

In some trials it may be desirable to wait a number of looks before examining the trial for futility. This option
allows the beta to begin being spent after a specified number of looks.

The Number of Skipped Futility Looks should be less than the number of looks.
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Beta Spending Function
Specify the type of beta spending function to use.

The O'Brien-Fleming Analog spends very little beta at the beginning and much more at the final looks. The
Pocock Analog and (Beta)(Time) spending functions spend beta more evenly across the looks. The Hwang-Shih-
DeCani (C) (sometimes called the gamma family) spending functions and (Beta)(Time”C) spending functions are
flexible spending functions that can be used to spend more beta early or late or evenly, depending on the choice of
C.

C (Beta Spending)
C is used to define the Hwang-Shih-DeCani (C) or (Beta)(Time”C) spending functions.

For the Hwang-Shih-DeCani (C) spending function, negative values of C spend more of beta at later looks, values
near 0 spend beta evenly, and positive values of C spend more of beta at earlier looks.

For the (Beta)(Time"C) spending function, only positive values for C are permitted. Values of C near zero spend
more of beta at earlier looks, values near 1 spend beta evenly, and larger values of C spend more of beta at later
looks.

Looks and Boundaries — Custom Specification

Number of Looks
This is the total number of looks of either type (significance or futility or both).

Equally Spaced

If this box is checked, the Accumulated Information boxes are ignored and the accumulated information is evenly
spaced.

Type of Futility Boundary

This option determines whether or not futility boundaries will be created, and if so, whether they are binding or
non-binding.

Futility boundaries are boundaries such that, if crossed at a given look, stop the study in favor of HO.

Binding futility boundaries are computed in concert with significance boundaries. They are called binding

because they require the stopping of a trial if they are crossed. If the trial is not stopped, the probability of a false
positive will exceed alpha.

When Non-binding futility boundaries are computed, the significance boundaries are first computed, ignoring the
futility boundaries. The futility boundaries are then computed. These futility boundaries are non-binding because
continuing the trial after they are crossed will not affect the overall probability of a false positive declaration.

Accumulated Information

The accumulated information at each look defines the proportion or percent of the sample size that is used at that
look.

These values are accumulated information values so they must be increasing.

Proportions, percents, or sample sizes may be entered. All proportions, percents, or sample sizes will be divided
by the value at the final look to create an accumulated information proportion for each look.

Percent of Alpha Spent
This is the percent of the total alpha that is spent at the corresponding look. It is not the cumulative value.

Percents, proportions, or alphas may be entered here. Each of the values is divided by the sum of the values to
obtain the proportion of alpha that is used at the corresponding look.
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Percent of Beta Spent
This is the percent of the total beta (1-power) that is spent at the corresponding look. It is not the cumulative
value.

Percents, proportions, or betas may be entered here. Each of the values is divided by the sum of the values to
obtain the proportion of beta that is used at the corresponding look.

Looks & Boundaries Tab when Solving for Alpha and Power

The Looks & Boundaries tab contains settings for the looks and significance boundaries.

Looks and Boundaries

Number of Looks
This is the total number of looks of either type (significance or futility or both).

Equally Spaced
If this box is checked, the Accumulated Information boxes are ignored and the accumulated information is evenly
spaced.

Types of Boundaries
This option determines whether or not futility boundaries will be entered.
Futility boundaries are boundaries such that, if crossed at a given look, stop the study in favor of HO.

Accumulated Information

The accumulated information at each look defines the proportion or percent of the sample size that is used at that
look.

These values are accumulated information values so they must be increasing.

Proportions, percents, or sample sizes may be entered. All proportions, percents, or sample sizes will be divided
by the value at the final look to create an accumulated information proportion for each look.

Significance Boundary

Enter the value of the significance boundary corresponding to the chosen test statistic. These are sometimes called
efficacy boundaries.

Futility Boundary
Enter the value of the futility boundary corresponding to the chosen test statistic.
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Options Tab

The Options tab contains limits on the number of iterations and various options about individual tests.

Maximum Sample Size Searched
Maximum N1 Before Search Termination
Specify the maximum N1 before the search for N1 is aborted.

Since simulations for large sample sizes are very computationally intensive and hence time-consuming, this value
can be used to stop searches when N1 is larger than reasonable sample sizes for the study.

This applies only when "Solve For" is set to Sample Size (N1).

The procedure uses a binary search when searching for N1. If a value for N1 is tried that exceeds this value, and
the power is not reached, a warning message will be shown on the output indicating the desired power was not
reached.

We recommend a value of at least 20000.

Matching Boundaries at Final Look

Beta Search Increment
For each simulation, when futility bounds are computed, the appropriate beta is found by searching from 0 to 1 by
this increment. Smaller increments are more refined, but the search takes longer.

We recommend 0.001 or 0.0001.

Zero Count Adjustment

Zero Count Adjustment Method

Zero cell counts cause many calculation problems. To compensate for this, a small value (called the Zero Count
Adjustment Value) may be added either to all cells or to all cells with zero counts. This option specifies whether
you want to use the adjustment and which type of adjustment you want to use.

Adding a small value is controversial, but may be necessary. Some statisticians recommend adding 0.5 while
others recommend 0.25. We have found that adding values as small as 0.0001 seems to work well.

Zero Count Adjustment Value
Zero cell counts cause many calculation problems. To compensate for this, a small value may be added either to
all cells or to all zero cells. This is the amount that is added.

Some statisticians recommend that the value of 0.5 be added to all cells (both zero and non-zero). Others
recommend 0.25. We have found that even a value as small as 0.0001 works well.
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Example 1 — Power and Output

A clinical trial is to be conducted over a two-year period to compare the proportion response of a new treatment to
that of the current treatment. The current response proportion is 0.56. Although the researchers do not know the
true proportion of patients that will survive with the new treatment, they would like to examine the power that is
achieved if the proportion under the new treatment is 0.63. The sample size at the final look is to be 1000 per
group. Testing will be done at the 0.05 significance level. A total of five tests are going to be performed on the
data as they are obtained. The O’Brien-Fleming (Analog) boundaries will be used. .

Find the power and test boundaries assuming equal sample sizes per arm and two-sided hypothesis tests.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Group-Sequential Tests for Two Proportions (Simulation) procedure window by expanding
Proportions, then Two Independent Proportions, then clicking on Group-Sequential, and then clicking on
Group-Sequential Tests for Two Proportions (Simulation). You may then make the appropriate entries as
listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

Option Value

Design Tab

SOIVE FOI coveeiiieeee e Power
TESETYPE oo Z-Test (Pooled)
Alternative Hypothesis...................o.o.... Two-Sided
SIMUIations .......c.ovevviiiiiie 100000

AP ..o 0.05

Group Allocation .........cccceevieveeiiiiieeeine Equal (N1 = N2)
Sample Size Per Group.........cccccevvveeenn. 1000

INPUL TYPE ..o Proportions

P1 (Proportion in Group 1|H1)................ 0.56

P2 (Proportion in Group 2) ........cccceeeenee 0.63

Looks & Boundaries Tab
Specification of Looks and Boundaries .. Simple

Number of Equally Spaced Looks.......... 5
Alpha Spending Function ....................... O’Brien-Fleming Analog
Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots

Scenario 1 Numeric Results for Group Sequential Testing Proportion Difference = 0.
Hypotheses: HO: Proportion 1 = Proportion 2; H1: Proportion 1 # Proportion 2

Test Statistic: Z-Test (Pooled)

Zero Adjustment Method: Add 0 to each zero

Alpha-Spending Function: O'Brien-Fleming Analog

Beta-Spending Function: None

Futility Boundary Type: None

Number of Looks: 5

Simulations: 100000
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Numeric Summary for Scenario 1

Power Alpha
Value 95% LCL 95% UCL Target Actual 95% LCL  95% UCL Beta
0.885 0.883 0.887 0.050 0.051 0.050 0.052 0.115
----- Average Sample Size ----
-- Given HO -- -- Given H1 --
N1 N2 Grpl Grp2 Grpl Grp2 Diff0 Diffl P1|H1 P2
1000 1000 993 993 757 757 0.0 -0.1 0.6 0.6
References

Jennison, C.; Turnbull, B.W. 2000. Group Sequential Methods with Applications to Clinical Trials. Chapman &

Hall. Boca Raton, FL.

Matsumoto, M. and Nishimura, T. 1998. ‘Mersenne twister: A 623-dimensionally equidistributed uniform
pseudorandom number generator.' ACM Trans. On Modeling and Computer Simulations.

Report Definitions

Power is the probability of rejecting a false null hypothesis at one of the looks. It is the total proportion
of alternative hypothesis simulations that are outside the significance boundaries.
Power 95% LCL and UCL are the lower and upper confidence limits for the power estimate. The width of the

interval is based on the number of simulations.

Target Alpha is the user-specified probability of rejecting a true null hypothesis. It is the total alpha

spent.

Alpha or Actual Alpha is the alpha level that was actually achieved by the experiment. It is the total
proportion of the null hypothesis simulations that are outside the significance boundaries.
Alpha 95% LCL and UCL are the lower and upper confidence limits for the actual alpha estimate. The width of

the interval is based on the number of simulations.

Beta is the probability of accepting a false null hypothesis. It is the total proportion of alternative

hypothesis simulations that do not cross the significance boundaries.

N1 and N2 are the sample sizes of each group if the study reaches the final look.
Average Sample Size Given HO Grpl and Grp2 are the average or expected sample sizes of each group if HO is
true. These are based on the proportion of null hypothesis simulations that cross the significance or

futility boundaries at each look.

Average Sample Size Given H1 Grpl and Grp2 are the average or expected sample sizes of each group if H1 is
true. These are based on the proportion of alternative hypothesis simulations that cross the significance

or futility boundaries at each look.

Diff0 is the proportion difference between groups (Grpl - Grp2) assuming the null hypothesis, HO.
Diffl is the proportion difference between groups (Grpl - Grp2) assuming the alternative hypothesis, H1.

P1|H1 is the proportion used in the simulations for Group 1 under H1.

P2 is the proportion used in the simulations for Group 1 and Group 2 under HO, and for Group 2 under H1.

Summary Statements

Group sequential trials with sample sizes of 1000 and 1000 at the final look achieve 89% power
to detect a difference of -0.1 between a treatment group proportion of 0.6 and a control group
proportion of 0.6 at the 0.101 significance level (alpha) using a two-sided Z-Test (Pooled).

Accumulated Information Details for Scenario 1

Accumulated

Information ~ -------- Accumulated Sample Size --------
Look Percent Group 1 Group 2 Total
1 20.0 200 200 400
2 40.0 400 400 800
3 60.0 600 600 1200
4 80.0 800 800 1600
5 100.0 1000 1000 2000

Accumulated Information Details Definitions
Look is the number of the look.

Accumulated Information Percent is the percent of the sample size accumulated up to the corresponding look.
Accumulated Sample Size Group 1 is total number of individuals in group 1 at the corresponding look.
Accumulated Sample Size Group 2 is total number of individuals in group 2 at the corresponding look.
Accumulated Sample Size Total is total number of individuals in the study (group 1 + group 2) at the

corresponding look.
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Boundaries for Scenario 1

-- Significance Boundary --

Z-Value
Look Scale
1 +/- 4.418
2 +/- 3.364
3 +/- 2.716
4 +/- 2.290
5 +/- 2.022

Boundaries Definitions

NCSS.com

Group-Sequential Tests for Two Proportions (Simulation)

P-Value
Scale
0.000
0.001
0.007
0.022
0.043

Look is the number of the look.

Significance Boundary Z-Value Scale is the value such that statistics outside this boundary at the
corresponding look indicate termination of the study and rejection of the null hypothesis. They are
sometimes called efficacy boundaries.

Significance Boundary P-Value Scale is the value such that P-Values outside this boundary at the corresponding
look indicate termination of the study and rejection of the null hypothesis. This P-Value corresponds to
the Z-Value Boundary and is sometimes called the nominal alpha.

Boundary Plot
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Significance Boundaries with 95% Simulation Confidence Intervals for Scenario 1

————————— Z-Value Boundary ---------  --------- P-Value Boundary ---------
Look Value 95% LCL 95% UCL Value 95% LCL 95% UCL
1 +/- 4.418 0.000
2 +/- 3.364 -3.488 -3.302 0.001 0.000 0.001
3 +/-2.716 -2.753 -2.677 0.007 0.006 0.007
4 +/- 2.290 -2.318 -2.272 0.022 0.020 0.023
5 +/- 2.022 -2.038 -2.000 0.043 0.042 0.045

Significance Boundary Confidence Limit Definitions

Look is the number of the look.

Z-Value Boundary Value is the value such that statistics outside this boundary at the corresponding look
indicate termination of the study and rejection of the null hypothesis. They are sometimes called efficacy
boundaries.

P-Value Boundary Value is the value such that P-Values outside this boundary at the corresponding look
indicate termination of the study and rejection of the null hypothesis. This P-Value corresponds to the
Z-Value Boundary and is sometimes called the nominal alpha.

95% LCL and UCL are the lower and upper confidence limits for the boundary at the given look. The width of the
interval is based on the number of simulations.

Alpha-Spending and Null Hypothesis Simulation Details for Scenario 1

--------- Target Actual Proportion Cum.

Cum. H1 Sims  H1 Sims

--- Signif. Boundary--- Spending Spending Cum. Outside Outside

Z-Value P-Value Function Function Alpha Alpha Signif. Signif.

Look Scale Scale Alpha Alpha Spent Spent Boundary Boundary
1 +/- 4.418 0.000 0.000 0.000 0.000 0.000 0.001 0.001
2 +/- 3.364 0.001 0.001 0.001 0.001 0.001 0.087 0.089
3 +/-2.716 0.007 0.007 0.008 0.007 0.007 0.316 0.405
4 +/- 2.290 0.022 0.017 0.024 0.017 0.025 0.318 0.723
B +/- 2.022 0.043 0.026 0.050 0.026 0.051 0.162 0.885

Alpha-Spending Details Definitions

Look is the number of the look.

Significance Boundary Z-Value Scale is the value such that statistics outside this boundary at the
corresponding look indicate termination of the study and rejection of the null hypothesis. They are
sometimes called efficacy boundaries.

Significance Boundary P-Value Scale is the value such that P-Values outside this boundary at the corresponding
look indicate termination of the study and rejection of the null hypothesis. This P-Value corresponds to
the Significance Z-Value Boundary and is sometimes called the nominal alpha.

Spending Function Alpha is the intended portion of alpha allocated to the particular look based on the
alpha-spending function.

Cumulative Spending Function Alpha is the intended accumulated alpha allocated to the particular look. It is
the sum of the Spending Function Alpha up to the corresponding look.

Alpha Spent is the proportion of the null hypothesis simulations resulting in statistics outside the
Significance Boundary at this look.

Cumulative Alpha Spent is the proportion of the null hypothesis simulations resulting in Significance Boundary
termination up to and including this look. It is the sum of the Alpha Spent up to the corresponding look.

Proportion H1 Sims Outside Significance Boundary is the proportion of the alternative hypothesis simulations
resulting in statistics outside the Significance Boundary at this look. It may be thought of as the
incremental power.

Cumulative H1 Sims Outside Significance Boundary is the proportion of the alternative hypothesis simulations
resulting in Significance Boundary termination up to and including this look. It is the sum of the
Proportion H1 Sims Outside Significance Boundary up to the corresponding look.

The values obtained from any given run of this example will vary slightly due to the variation in simulations.
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Example 2 — Power for One-Sided Test with Futility Boundaries

Suppose researchers would like to compare two treatments with a one-sided test at each look. Further, suppose
they would like to terminate the study early when it can be deemed highly unlikely that the new treatment is better
than the standard. Suppose the control group proportion is 0.46. The researchers wish to know the power of the
test if the treatment group proportion is 0.53. The sample size at the final look is to be 1000 per group. Testing
will be done at the 0.05 significance level. A total of five tests are going to be performed on the data as they are
obtained. The O’Brien-Fleming (Analog) boundaries will be used for both significance and futility boundaries.

Find the power and test boundaries assuming equal sample sizes per arm and one-sided hypothesis tests.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Group-Sequential Tests for Two Proportions (Simulation) procedure window by expanding
Proportions, then Two Independent Proportions, then clicking on Group-Sequential, and then clicking on
Group-Sequential Tests for Two Proportions (Simulation). You may then make the appropriate entries as
listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

Option Value

Design Tab

SOIVE FOI coveeiiieeee e Power
TESETYPE oo Z-Test (Pooled)
Alternative Hypothesis...................o.o.... One-Sided (Propl > Prop2)
SIMulations .......c.c.eeevviiiii 100000

AP ... 0.05

Group Allocation .........cccceeviieeeiiiiiceeinn Equal (N1 = N2)
Sample Size Per Group.......cccccceeveveeenn. 1000

INPUL TYPE ..o Proportions

P1 (Proportion in Group 1|H1)................ 0.53

P2 (Proportion in Group 2) ........ccceeeeennee 0.46

Looks & Boundaries Tab
Specification of Looks and Boundaries .. Simple

Number of Equally Spaced Looks.......... 5

Alpha Spending Function ...................... O’Brien-Fleming Analog
Type of Futility Boundary............ccoeeens Non-Binding

Number of Skipped Futility Looks........... 0

Beta Spending Function ......................... O’Brien-Fleming Analog
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Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots

Scenario 1 Numeric Results for Group Sequential Testing Proportion Difference = 0.
Hypotheses: HO: Proportion 1 = Proportion 2; H1: Proportion 1 > Proportion 2

Test Statistic: Z-Test (Pooled)

Zero Adjustment Method: Add O to each zero

Alpha-Spending Function: O'Brien-Fleming Analog

Beta-Spending Function: O'Brien-Fleming Analog

Futility Boundary Type: Non-Binding

Number of Looks: 5

Simulations: 100000

Numeric Summary for Scenario 1

Power Alpha
Value 95% LCL 95% UCL Target Actual 95% LCL  95% UCL Beta
0.904 0.902 0.905 0.050 0.045 0.044 0.047 0.096
----- Average Sample Size ----
-- Given HO -- -- Given H1 --
N1 N2 Grpl Grp2 Grpl Grp2 Diffo  Diffl P1|H1 P2

1000 1000 600 600 675 675 0.0 0.1 0.5 0.5
Accumulated Information Details for Scenario 1

Accumulated

Information ~ ------- Accumulated Sample Size --------
Look Percent Group 1 Group 2 Total
1 20.0 200 200 400
2 40.0 400 400 800
3 60.0 600 600 1200
4 80.0 800 800 1600
5 100.0 1000 1000 2000

Boundaries for Scenario 1

-- Significance Boundary --  ----- Futility Boundary -----
Z-Value P-Value Z-Value P-Value
Look Scale Scale Scale Scale
1 4.020 0.000 -2.100 0.982
2 2.902 0.002 -0.424 0.664
3 2.312 0.010 0.520 0.302
4 1.958 0.025 1.200 0.115
5 1.746 0.040 1.746 0.040
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Boundary Plot

Boundary Value

P-Value
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Boundary Plot

4.5 -
Q.
3.5 1
[o]
2.5
©
o
1.5
Boundary Type
© Sig. Boundary
05 @ Fut. Boundary
T T !
3 4 5
-0.5
-1.5 4
2.5
Look
Boundary Plot - P-Value
Boundary Plot
1.0 4
0.8
0.6
Boundary Type
@ Sig. Boundary
@ Fut. Boundary
0.4 4
0.2 4
~—
000 Q ‘
1 3 5
Look

Significance Boundaries with 95% Simulation Confidence Intervals for Scenario 1

--------- Z-Value Boundary
95% LCL 95% UCL

Value
4.020
2.902
2.312
1.958
1.746

2.841
2.263
1.955
1.707

2.946
2.317
1.964
1.749

Value
0.000
0.002
0.010
0.025
0.040

P-Value Boundary

95% LCL 95% UCL

0.002
0.010
0.025
0.040
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Futility Boundaries with 95% Simulation Confidence Intervals for Scenario 1

————————— Z-Value Boundary ---------  --------- P-Value Boundary ---------
Look Value 95% LCL 95% UCL Value 95% LCL 95% UCL
1 -2.100 -2.300 -2.000 0.982
2 -0.424 -0.425 -0.424 0.664 0.664 0.664
3 0.520 0.520 0.577 0.302 0.282 0.302
4 1.200 1.200 1.200 0.115 0.115 0.115
5 1.746 1.745 1.789 0.040 0.037 0.041

Alpha-Spending and Null Hypothesis Simulation Details for Scenario 1

--------- Target Actual Proportion Cum.

Cum. HO Sims  HO Sims

--- Signif. Boundary--- Spending Spending Cum. Outside Outside

Z-Value P-Value Function Function Alpha Alpha Futility Futility

Look Scale Scale Alpha Alpha Spent Spent Boundary Boundary
1 4.020 0.000 0.000 0.000 0.000 0.000 0.019 0.019
2 2.902 0.002 0.002 0.002 0.002 0.002 0.329 0.348
3 2.312 0.010 0.009 0.011 0.009 0.011 0.352 0.700
4 1.958 0.025 0.017 0.028 0.017 0.028 0.189 0.890
5 1.746 0.040 0.022 0.050 0.017 0.045 0.065 0.955

Beta-Spending and Alternative Hypothesis Simulation Details for Scenario 1

————————— Target Actual Proportion Cum.

Cum. H1 Sims  H1 Sims

-- Futility Boundary-- Spending Spending Cum. Outside Outside

Z-Value P-Value Function Function Beta Beta Signif. Signif.

Look Scale Scale Beta Beta Spent Spent Boundary Boundary
1 -2.100 0.982 0.000 0.000 0.000 0.000 0.004 0.004
2 -0.424 0.664 0.008 0.009 0.008 0.009 0.168 0.172
3 0.520 0.302 0.023 0.032 0.023 0.032 0.369 0.541
4 1.200 0.115 0.031 0.064 0.031 0.063 0.263 0.803
5 1.746 0.040 0.033 0.097 0.033 0.096 0.100 0.904

The values obtained from any given run of this example will vary slightly due to the variation in simulations.
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Example 3 — Enter Boundaries

With a set-up similar to Example 2, suppose we wish to investigate the properties of a set of significance (3, 3, 3,
2, 2) and futility (-2, -1, 0, 0, 0) boundaries.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Group-Sequential Tests for Two Proportions (Simulation) procedure window by expanding
Proportions, then Two Independent Proportions, then clicking on Group-Sequential, and then clicking on
Group-Sequential Tests for Two Proportions (Simulation). You may then make the appropriate entries as
listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

Option Value

Design Tab

SOIVE FOI oo Alpha and Power (Enter Boundaries)
TESE TYPE et Z-Test (Pooled)

Alternative Hypothesis............cccceviineen. One-Sided (Propl > Prop2)
SIMUIALIONS ..o 100000

Group Allocation .........coevvveveviiiiiiiiinenen, Equal (N1 =N2)

Sample Size Per Group......ccccccceeveveeenn. 1000

INPUL TYPE .o Proportions

P1 (Proportion in Group 1|H1)................ 0.53

P2 (Proportion in Group 2) ........ccceeeeennee 0.46

Looks & Boundaries Tab

Number of LOOKS .........cccovvvvvieiiiiiicc 5

Equally Spaced...........cccccoevvviviiiiiiinnnnn, Checked

Types of Boundaries.........ccccoeeeeiiieeennns Significance and Futility Boundaries
Significance Boundary ............cccccoeeeennne 33322 (for looks 1 through 5)
Futility Boundary .........ccccccvevvviiiiiinnnnnn, -2-1000 (for looks 1 through 5)
Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots

Scenario 1 Numeric Results for Group Sequential Testing Proportion Difference = 0.
Hypotheses: HO: Proportion 1 = Proportion 2; H1: Proportion 1 > Proportion 2

Test Statistic: Z-Test (Pooled)

Zero Adjustment Method: Add O to each zero

Type of Boundaries: Significance and Futility Boundaries

Number of Looks: 5

Simulations: 100000
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Numeric Summary for Scenario 1

Power Alpha
Value 95% LCL 95% UCL Value 95% LCL 95% UCL
0.890 0.888 0.892 0.035 0.034 0.036
----- Average Sample Size ----
-- Given HO -- -- Given H1 --
N1 N2 Grpl Grp2 Grpl Grp2 Diff0 Diffl P1|H1L P2
1000 1000 403 403 625 625 0.0 0.1 0.5 0.5

Accumulated Information Details for Scenario 1

Accumulated

Information ~ ------- Accumulated Sample Size --------
Look Percent Group 1 Group 2 Total
1 20.0 200 200 400
2 40.0 400 400 800
3 60.0 600 600 1200
4 80.0 800 800 1600
5 100.0 1000 1000 2000
Boundaries for Scenario 1
-- Significance Boundary --  ----- Futility Boundary -----
Z-Value P-Value Z-Value P-Value
Look Scale Scale Scale Scale
1 3.000 0.001 -2.000 0.977
2 3.000 0.001 -1.000 0.841
3 3.000 0.001 0.000 0.500
4 2.000 0.023 0.000 0.500
5 2.000 0.023 0.000 0.500
Boundary Plot
Boundary Plot
30, o o e
2.0+ o o
3 10
3 Boundary Type
E @ Sig. Boundary
B @ Fut. Boundary
3 00 ® ®
@ 4 5
-1.0 -
-20-

Look
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Boundary Plot - P-Value

Boundary Plot

1.0 -
0.8 4
0.6 4
5 Boundary Type
g ® L ® O Sig. Boundary
a @® Fut. Boundary
0.4+
0.2+
006 ° ° . $
1 2 3 4 5

Look

Alpha-Spending and Null Hypothesis Simulation Details for Scenario 1

Proportion Cum.

HO Sims HO Sims

--- Signif. Boundary--- Cum. Outside Outside

Z-Value P-Value Alpha Alpha Futility Futility

Look Scale Scale Spent Spent Boundary Boundary
1 3.000 0.001 0.002 0.002 0.025 0.025
2 3.000 0.001 0.001 0.003 0.132 0.157
3 3.000 0.001 0.001 0.004 0.336 0.493
4 2.000 0.023 0.022 0.026 0.082 0.575
5 2.000 0.023 0.009 0.035 0.050 0.625

Beta-Spending and Alternative Hypothesis Simulation Details for Scenario 1

Proportion Cum.

H1 Sims H1 Sims

-- Futility Boundary-- Cum. Outside Outside

Z-Value P-Value Beta Beta Signif. Signif.

Look Scale Scale Spent Spent Boundary Boundary
1 -2.000 0.977 0.000 0.000 0.059 0.059
2 -1.000 0.841 0.001 0.002 0.111 0.170
3 0.000 0.500 0.006 0.008 0.153 0.323
4 0.000 0.500 0.001 0.009 0.477 0.800
B 0.000 0.500 0.000 0.009 0.091 0.890

The values obtained from any given run of this example will vary slightly due to the variation in simulations.
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Example 4 — Validation using O’Brien-Fleming Boundaries

Reboussin (1992) presents an example for binomial distributed data for a design with two-sided O’Brien-Fleming
boundaries, looks = 5, alpha = 0.05, beta = 0.10, P1 = 0.1100, P2 = 0.0825. They compute a drift of 3.28 and a
sample size of 2381.78 per group. The upper boundaries are: 4.8769, 3.3569, 2.6803, 2.2898, 2.0310.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Group-Sequential Tests for Two Proportions (Simulation) procedure window by expanding
Proportions, then Two Independent Proportions, then clicking on Group-Sequential, and then clicking on
Group-Sequential Tests for Two Proportions (Simulation). You may then make the appropriate entries as
listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

Option Value

Design Tab

SOIVE FOr oo Sample Size
TESETYPE oo Z-Test (Pooled)
Alternative Hypothesis...................oco. Two-Sided
SIMulations .........eeeevieiiii 100000

POWET ... 0.90

AP ... 0.05

Group Allocation ..........cevvvvveviiiiiiiiinenen, Equal (N1 = N2)
INPUL TYPE ..o Proportions

P1 (Proportion in Group 1|H1)................ 0.1100

P2 (Proportion in Group 2) ........cccceeeeneee 0.0825

Looks & Boundaries Tab
Specification of Looks and Boundaries .. Simple

Number of Equally Spaced Looks.......... 5
Alpha Spending Function .............c......... O’'Brien-Fleming Analog
Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots

Scenario 1 Numeric Results for Group Sequential Testing Proportion Difference = 0.
Hypotheses: HO: Proportion 1 = Proportion 2; H1: Proportion 1 # Proportion 2

Test Statistic: Z-Test (Pooled)

Zero Adjustment Method: Add 0 to each zero

Alpha-Spending Function: O'Brien-Fleming Analog

Beta-Spending Function: None

Futility Boundary Type: None

Number of Looks: 5

Simulations: 100000
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Numeric Summary for Scenario 1

Power Alpha
Value 95% LCL 95% UCL Target Actual 95% LCL  95% UCL Beta
0.900 0.899 0.902 0.050 0.097 0.095 0.099 0.100
----- Average Sample Size ----
-- Given HO -- -- Given H1 --
N1 N2 Grpl Grp2 Grpl Grp2 Diff0 Diffl P1|H1L P2

2487 2487 2456 2456 1830 1830 0.0 0.0 0.1 0.1

The values obtained from any given run of this example will vary slightly due to the variation in simulations.

The sample size generated in this run is 2487. As discussed in Example 5 of Chapter 220, the correct sample size
is 2474. Each run of this simulation procedure may produce a slightly different value for the sample size,
especially if the number of simulations is lower. Larger numbers of simulations are required to obtain the
increased precision for the boundary values. A run with N1 and N2 equal to 2474 and 1000000 simulations gives
the following boundaries.

Boundaries for Scenario 1

-- Significance Boundary --

Z-Value P-Value
Look Scale Scale
1 +/- 4.154 0.000
2 +/- 3.334 0.001
3 +/- 2.685 0.007
4 +/- 2.313 0.021
5 +/- 2.058 0.040

These values are slightly off at the second or third decimal place, showing that very large simulation numbers are
needed to obtain accurate boundaries.
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Example 5 — Validation Using Simulation

With a set-up similar to Example 1, we examine the power and alpha generated by the set of two-sided
significance boundaries (+/- 4.418, +/- 3.364, +/- 2.716, +/- 2.290, +/- 2.022).

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Group-Sequential Tests for Two Proportions (Simulation) procedure window by expanding
Proportions, then Two Independent Proportions, then clicking on Group-Sequential, and then clicking on
Group-Sequential Tests for Two Proportions (Simulation). You may then make the appropriate entries as
listed below, or open Example 5 by going to the File menu and choosing Open Example Template.

Option Value

Design Tab

SOIVE FOI oo Alpha and Power (Enter Boundaries)
TESE TYPE et Z-Test (Pooled)

Alternative Hypothesis............cccceviineen. Two-Sided

SIMUIALIONS ...eeeeiiiiceeee e 100000

Group Allocation .........ccevvveveviiiiiiiiiiennn, Equal (N1 =N2)

Sample Size Per Group.........ccccoevvveeen. 1000

INPUL TYPE .ot Proportions

P1 (Proportion in Group 1|H1)................ 0.56

P2 (Proportion in Group 2) ........ccccceeenee 0.63

Looks & Boundaries Tab

Number of LOOKS ......cccuvveeiviiiiiiiiiiieee, 5

Equally Spaced...........ccccovvvviviiiiiiinn, Checked

Significance Boundary..........cccccccoeeuvneee. 4.418, 3.364, 2.716, 2.290, 2.022 (looks 1 through 5)
Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots

Scenario 1 Numeric Results for Group Sequential Testing Proportion Difference = 0.
Hypotheses: HO: Proportion 1 = Proportion 2; H1: Proportion 1 # Proportion 2

Test Statistic: Z-Test (Pooled)

Zero Adjustment Method: Add 0 to each zero

Type of Boundaries: Significance Boundaries Only

Number of Looks: 5

Simulations: 100000

Numeric Summary for Scenario 1

Power Alpha
Value 95% LCL 95% UCL Value 95% LCL 95% UCL Beta
0.886 0.884 0.888 0.051 0.049 0.052 0.114

----- Average Sample Size ----

-- Given HO -- -- Given H1 --
N1 N2 Grpl Grp2 Grpl Grp2 Diffo  Diffl P1|H1 P2
1000 1000 993 993 756 756 0.0 -0.1 0.6 0.6

The values obtained from any given run of this example will vary slightly due to the variation in simulations. The
power and alpha generated with these boundaries are very close to the values of Example 1.
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